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Overview 
This document is designed to improve your overall experience with Microsoft Dynamics CRM Online (CRM 

Online), even before your business begins using the solution.   

This document is a compilation of  common configuration settings and tasks to help keep your CRM Online 

organization optimized so you can focus on what’s most important. This document also includes important online 

resources your entire business can leverage over and over again. 

Who is this document for?  Every CRM “Administrator” and User using CRM Online. 



Common Configuration Settings for Internet Explorer  

CRM Online is a web-based application, and uses Internet Explorer as the user interface (UI) to 

view/edit/add/remove information you have stored in your CRM database.  The following are common Internet 

Explorer configuration settings  which will help optimize your CRM Online experience. 

Increase simultaneous download session 
By default, Windows Internet Explorer 7 (and earlier versions) limit the number of files you can download at one 

time to two. Windows Internet Explorer 8 limits the number of files that you can download at one time to six.  

The CRM Online application synchronously requests data to and from the CRM Online data center.  In many cases, 

you can easily exhaust the number of simultaneous downloads when using CRM Online.  To increase this limit, 

review KB article 282402: http://support.microsoft.com/kb/282402  

Either use the Fix it option or work through the "Let me fix it myself" section 

 

 

http://support.microsoft.com/kb/282402
http://go.microsoft.com/?linkid=9643522
http://go.microsoft.com/?linkid=9643522


Add appropriate URLs to Trusted Sites 
The Internet Explorer Security tab is used to set and change options that can help protect your computer from 
potentially harmful or malicious online content.  By placing the URLs used for CRM Online into the Trusted Sites, it 
places less restrictions for these web sites.  To accomplish: 

a. Open up Internet Explorer (IE) 
b. Go to Tools > Internet Options 
c. Click the Security tab 
d. Click Trusted Sites > Sites 
e. If you get another window that allows you to click Advanced please do so, then add the following 

URLs: 
*.dynamics.com 
*.live.com 

NOTE: If you get a pop-up window that states: 
Sites added to this zone must use the  https:// prefix. This prefix assures a secure connection. 

Uncheck the box for "Require server verification (https:) for all sites in this zone" 

f. Click Close and then click OK 
 

             
  



Increase Disk Space Size for Temporary Internet Files 
To ensure internet files for CRM Online are not being deleted, increase your Temporary Internet Files disk space. 

To do so: 

a. Open Internet Explorer (IE) 
b. Navigate to Tools and then click Internet Options 
c. Under the General tab in the Browsing history section click on Settings 
d. Update the field "Disk space to use" to 350 

Note: Default is 50 
e. Click OK and then click OK again 

 

        
 

  



Leave the "Delete browsing history on exit" option UNMARKED 
If you enable this option, all of your browsing history is deleted when you close Internet Explorer.  It deletes 

everything marked within your Browsing History Settings button.  To optimize your CRM Online experience, we 

recommend you leave this box UNMARKED. 

By default, Temporary Internet files, Cookies, and History are enabled.  Deleting your Temporary Internet files, 

will cause IE to cache the files again, and deleting the Cookies will cause you to be signed out of CRM Online.    

a. Open up Internet Explorer (IE) 
b. Go to Tools and then click Internet Options 

c. Under the General tab locate the Browsing history section 

d. Ensure the check box "Delete browsing history on exit" is UNMARKED. 

 

  



Add Microsoft Dynamics CRM URLs to allow pop-ups 
CRM Online uses pop-up windows, such as when a new CRM record is opened or created.  These pop-up windows 

can be blocked by the Internet Explorer Pop-up Blocker.  You must configure the Pop-up Blocker to allow the CRM 

Online URLs to be excluded from the Pop-up Blocker.  To allow CRM Online to be excluded from the Internet 

Explorer Pop-up Blocker, go through the following. 

a. Open up Internet Explorer (IE) 

b. Click Tools, click Pop-up Blocker, click Pop-up Blocker Settings 

Note:  In internet explorer 9 this option can be found by clicking the Tools menu, clicking Internet 

Options, clicking the Privacy tab, and then clicking the Settings button within the Pop-Up Blocker 

section  

c. Add the following Microsoft Dynamics CRM Online URLs: 

*.dynamics.com 

*.live.com 
d. Click Close 

 

 

 

  



Ensure CRM Online is “white-listed” for anti-virus or malware applications 

CRM Online performance can be impacted negatively depending on your anti-virus or malware applications.  Virus 
scanning can lock certain files making them inaccessible to other applications.   

Each environment requires a thoughtful decision on what to include and exclude, and there is always a possibility 
that excluding files from scans can lead to unwanted consequences.   

This list should be used alongside well planned internal IT management policies. 

 Check for any interference from desktop security software.  Some anti-virus programs include a feature 
called ScriptScan which can affect performance in CRM Online.  Most programs have functionality to 
disable scanning on certain web sites.  Make sure the CRM Online URL is added to this list.  For McAfee 
specifically see the following KB articles for this setting:  

o https://kc.mcafee.com/corporate/index?page=content&id=KB65382  
o http://support.microsoft.com/kb/924341  

 
 If using other anti-virus software, make sure the CRM Online website URL is included in the trusted zone 

for the virus scanning and disable “on-access scanning” for the CRM Online website.  See your specific 
anti-virus application documentation for more details. 

 

 

 

 

Ensure you receive important e-mails from CRM Online 

Microsoft will occasionally send out e-mails to CRM Online users or administrators.  These e-mails can provide 

information about how to use CRM Online as well as critical billing or upgrade information.   

Ensure you have the following e-mail addresses added to the whitelist for your e-mail application. 

 crmoln@microsoft.com – This is the email alias that typical CRM Online alerts or information comes from. 

 billing@microsoft.com  – This email alias sends out information in regards to billing for CRM Online. 

 crmonline@e-mail.microsoft.com – This email alias sends out information emails when you sign up for 

CRM Online. 

https://kc.mcafee.com/corporate/index?page=content&id=KB65382
http://support.microsoft.com/kb/924341
mailto:crmoln@microsoft.com
mailto:billing@microsoft.com
mailto:crmonline@e-mail.microsoft.com


Configuring the CRM for Outlook Client 
There are some options that can be used to help optimize certain processes with the CRM for Outlook Client.   

Ensure the CRM for Outlook Client has the most recent updates 
Microsoft periodically releases updates to correct unplanned issues.  In most cases, these updates are to help 

enhance performance or ensure greater stability.  It is important to have the latest updates for the CRM for 

Outlook Client as well.  Do the following on the workstation(s) that has the CRM for Outlook Client. 

a. Close Microsoft Outlook 

b. Click on the Windows button, click All Programs, and then click Windows Update 

c. Click on Change Settings 

d. Ensure under Microsoft Update the check box is checked for "Give me updates for Microsoft products and 

check for new optional Microsoft software when I update Windows".   

e. Click Ok 

f. Click on Check for updates 

 

NOTE: If you see a link beneath "You receive updates:" for "Check online for updates from Microsoft 

Update", click it to check for updates from the Microsoft servers.  If your updates are administered by 

your System Administrator(s), you may not have this option and would need to request them to make the 

Microsoft Dynamics CRM updates available. 

 

g. Click on Install updates 

NOTE: To review what updates are available, click on the "# important updates are available" link 

 

Figure 1: Showing a Microsoft Dynamics CRM 2011 update within Windows Update 



Enabling Automatic Synchronization for Online and Offline clients 
Enabling automatic synchronization allows the CRM for Outlook Client to systematically synchronize the data from 

the CRM Online data center.  This helps ensure your local data is regularly updated, so when you go offline, the 

amount of data required to synchronize locally is a manageably sized dataset.   

For Outlook synchronization, go through the following: 

Outlook 2010: 

1. Open up Microsoft Outlook with the Microsoft Dynamics CRM for Outlook Client enabled. 

2. Within Outlook, click on File tab. 

3. Click on CRM. 

4. Click on Options. 

 

 
 

5. Click the Synchronization tab. 

6. Under Schedule automatic synchronization with Outlook, ensure Synchronize the CRM items in my 

Outlook folders every __ minutes is checked.   



Outlook 2003/2007: 

1. Open up Microsoft Outlook with the CRM for Outlook Client enabled. 

2. Within Outlook, click on the CRM menu, and then click Options. 

 
 

3. Click the Synchronization tab. 

4. Under Schedule automatic synchronization with Outlook, ensure Synchronize the CRM items in my 

Outlook folders every __ minutes is checked.   

NOTE: By default, Outlook synchronization is enabled and set for 15 minutes.    

 

For Offline synchronization, go through the following: 

Outlook 2010: 

1. Open up Microsoft Outlook with the CRM for Outlook Client enabled. 

2. Click the File tab. 

3. Click CRM. 



4. Click Options. 

5. Click the Local Data tab. 

6. Under Select how often to update local data, ensure the Update local data every__ minutes is checked. 

Outlook 2003/2007: 

1. Open up Microsoft Outlook with the CRM for Outlook Client enabled. 

2. Within Outlook, click on the CRM menu, click on Options. 

3. Click on Local Data tab. 

4. Under Select how often to update local data, ensure the Update local data every__ minutes is checked. 

NOTE: By default, the Offline synchronization is disabled. 

 

 

Tip for Tracking CRM Calendar Appointments in Microsoft Outlook 
To ensure your Calendar Appointments do not disappear in CRM Online after you begin to “track” them in 

Microsoft Outlook, be sure your user e-mail address on the respective CRM User record matches your e-mail 

address being used for Microsoft Outlook.  Note – the e-mail address may NOT be the same as your Windows Live 

ID. It depends on the e-mail addresses you are using in Outlook and on your CRM User record. 

       



RECOMMENDATION: Only synchronize essential data for your Online & Offline clients 
Limiting the amount of data you synchronize with your CRM for Outlook Clients can reduce the amount of 

network bandwidth being consumed by Microsoft Dynamics CRM users, and inherently improve your overall 

application performance.   

Outlook Filters: 

To modify the Outlook Filters that control which records synchronize with Outlook, simply go through the 

following: 

Outlook 2010: 

1. Open up Microsoft Outlook with the Microsoft Dynamics CRM for Outlook client enabled. 

2. Within Outlook, click the File tab. 

3. Click CRM. 

4. Click on the Synchronize button and then click Outlook Filters. 

 
 

5. Within the “Filter: Outlook” window, you can change the view between Outlook Synchronization Filters as 

well as Offline Synchronization Filters.   

6. Check the filters that you want to disable and click on the Deactivate button . 

OR 

Click on the filter you would like to modify to add some additional filtering.  For instance, changing the My 

Tasks filter to only synchronize My Open Tasks (see Figure 3). 



Outlook 2003/2007: 

1. Open up Microsoft Outlook with the CRM for Outlook Client enabled 

2. Within Outlook, click on the CRM menu, click on Outlook Filters/Offline Filters 

 
 

3. Within the Filter: Outlook window, you can change the view between Outlook Synchronization Filters as 

well as Offline Synchronization Filters.   

4. Check the filters that you want to disable and click on the Deactivate button . 

OR 

Click on the filter you would like to modify to add some additional filtering.  For instance, changing the My 

Tasks filter to only synchronize My Open Tasks: 

 

 

Figure 2: Deactivating an Outlook filter 

 



 

Figure 3: Modifying an Outlook filter to add additional filtering 

 

 

  



CRM Online Resources Available for CRM Users 
At Microsoft, we want you and your organization to take full advantage of the extensive content and materials 

available which can help your business be more successful when using CRM Online.  Here are resources available 

for all CRM Online users: 

CRM Online Resource Center 
Data in the Resource Center is aggregated from many resources, allowing you to search for relevant information 

quickly and efficiently.  It ranges from Mircrosoft published articles, the CRM Online Help file, the CRM Forum, 

and the Dynamics CRM Community.  Either through the application (bottom left-hand tab) or online, don’t miss an 

opportunity to take full advantage of what the Resource Center has to offer  

http://rc.crm.dynamics.com/rc/2011/en-us/online/default.aspx 

The Resource Center contains a list of Frequently Asked Questions as well  

http://rc.crm.dynamics.com/rc/2011/en-us/online/5.0/faq.aspx 

 

CRM Online E-Learning Catalogs: 
The E-Learning Catalog has a wealth of professional courses designed to help you use and configure CRM Online 

for your business. These courses are designed for your end-users as well as your CRM administrator  

https://dynamics.microsoftelearning.com/catalog/default.aspx?searchAction=keyword&keyword=crm  

Dynamics CRM Training Materials: 
Dynamics CRM Training Materials provide professional guides on the features and functionality of Microsoft 

Dynamics CRM.   

In order to use this resource, you will need to sign in with your Windows Live ID that is associated with your CRM 

Online user account  

https://mbs.microsoft.com/CMS/Templates/site/DLPP.aspx?NRMODE=Published&NRNODEGUID=%7bB0901DB5-

89CC-46EB-BCA2-

43D078C5EA2E%7d&NRORIGINALURL=%2fcustomersource%2fworldwide%2fus%2ftraining%2ftrainingmaterials%

2fstudent&NRCACHEHINT=Guest  

CRM Online Team Blog: 
This site is a collection of Microsoft's CRM experts on help, tips and tricks for CRM Online  

http://blogs.msdn.com/dynamicscrmonline. 

The Dynamics CRM Team Blog 
Similar to the CRM Online Team Blog, this expands to include all deployment types for Microsoft Dynamics CRM.  

Some information within this blog may not apply to Microsoft Dynamics CRM Online but one can find useful 

information around the application and customizations that apply to any deployment type of Microsoft Dynamics 

CRM  http://blogs.msdn.com/b/crm. 

http://rc.crm.dynamics.com/rc/2011/en-us/online/default.aspx
https://dynamics.microsoftelearning.com/catalog/default.aspx?searchAction=keyword&keyword=crm
https://mbs.microsoft.com/CMS/Templates/site/DLPP.aspx?NRMODE=Published&NRNODEGUID=%7bB0901DB5-89CC-46EB-BCA2-43D078C5EA2E%7d&NRORIGINALURL=%2fcustomersource%2fworldwide%2fus%2ftraining%2ftrainingmaterials%2fstudent&NRCACHEHINT=Guest
https://mbs.microsoft.com/CMS/Templates/site/DLPP.aspx?NRMODE=Published&NRNODEGUID=%7bB0901DB5-89CC-46EB-BCA2-43D078C5EA2E%7d&NRORIGINALURL=%2fcustomersource%2fworldwide%2fus%2ftraining%2ftrainingmaterials%2fstudent&NRCACHEHINT=Guest
https://mbs.microsoft.com/CMS/Templates/site/DLPP.aspx?NRMODE=Published&NRNODEGUID=%7bB0901DB5-89CC-46EB-BCA2-43D078C5EA2E%7d&NRORIGINALURL=%2fcustomersource%2fworldwide%2fus%2ftraining%2ftrainingmaterials%2fstudent&NRCACHEHINT=Guest
https://mbs.microsoft.com/CMS/Templates/site/DLPP.aspx?NRMODE=Published&NRNODEGUID=%7bB0901DB5-89CC-46EB-BCA2-43D078C5EA2E%7d&NRORIGINALURL=%2fcustomersource%2fworldwide%2fus%2ftraining%2ftrainingmaterials%2fstudent&NRCACHEHINT=Guest
http://blogs.msdn.com/dynamicscrmonline
http://blogs.msdn.com/b/crm


Microsoft Dynamics CRM Community: 
The Dynamics CRM Community is a common location for all CRM users to read about how other users are working 

with CRM Online.  Helpful blog posts, product news, and other events can be found here as well.  It is one of the 

best places in the world for users to ask (and answer) questions about CRM Online   

http://community.dynamics.com/product/crm/default.aspx 

Microsoft Dynamics CRM Online Video Gallery:  
The Microsoft Dynamics CRM Online Video Gallery has numerous videos on how you can use and maximize your 

business’ use of CRM Online.  There are also weekly interactive demonstrations on various topics including sales 

automation, application configuration and administration. Join the live sessions to ask questions and learn more 

about how Microsoft Dynamics CRM Online can help improve your business.   http://www.democrmonline.com  

  

 

Supporting your CRM Online Organization 
There are many ways one can get assistance with Microsoft Dynamics CRM Online.  Microsoft strives to share 

documentation to their customers so they can resolve issues in a very timely and efficient matter.  Below are the 

resources you could use to troubleshoot issues with Microsoft Dynamics CRM Online.  We recommend following 

this list to maximize the efficiency of resolving issues. 

Ask The Community 
The CRM Online Community is a large and active world-wide community, and is the best place to begin if you have 

questions regarding CRM Online usage and configuration.  The Community is set up to allow users to ask or 

answer questions about CRM Online.  In most cases, others in the Community have experienced the same 

question or business problem, and are willing to help you! With thousands of resources at your fingertips, the 

CRM Community gives you an opportunity to raise your question or issue to many resources at once, and to also 

help your fellow CRM Online users!  http://community.dynamics.com/product/crm/f/117.aspx  

Knowledgebase Search 
The Dynamics CRM support team and experts are continuously documenting known or common issues within 

Knowledge Base (KB) Articles.  If you experience an issue with the CRM Online application, you can typically find 

the solution by searching based on the error or by defining what you are trying to do.  There are articles available 

within the Dynamics CustomerSource knowledge base as well as the public Microsoft Support knowledge base  

https://mbs2.microsoft.com/CustomerSourceApp/search.aspx?st=a&ss=19482 & http://support.microsoft.com  

Advanced Product Support Services 
Support incidents provide reactive support that focuses on a specific problem, error message, or functionality that 

is not working as intended.  There may be times when you could benefit from additional services beyond what is 

provided within support. With access to technical professionals from Microsoft Dynamics, Advanced Product 

http://community.dynamics.com/product/crm/default.aspx
http://www.democrmonline.com/
http://community.dynamics.com/product/crm/f/117.aspx
https://mbs2.microsoft.com/CustomerSourceApp/search.aspx?st=a&ss=19482
http://support.microsoft.com/


Support Services (APSS) can provide the strategic technical assistance you need.  APSS encompass a wide variety 

of services and products designed to help you get the most from your Microsoft Dynamics products. 

You can access this resource by going to 

https://mbs.microsoft.com/customersource/worldwide/us/support/selfsupport/apss/default 

Microsoft Dynamics CRM Support 
If you are unable to find the answers or solutions within the resources discussed above, you can submit a 

technical support request to the Dynamics CRM Technical Support Team.  Technical Support Incidents provide 

reactive support that focuses on a specific problem, error message, or functionality that is not working as 

intended.  Below is how you submit an incident to the Dynamics CRM Technical Support Team. 

1. Login in your CRM Online organization, via www.crmonline.com. 

2. Within the application, navigate to the Resource Center. 

3. Within the Resource Center, navigate to the Support section, and then click Technical Support Request. 

Maximizing Your Technical Support Experience  
When requesting help for any technical issues or questions, it is important to have as much information available 

with you as possible.  Below are common questions you may be asked to answer when requesting help from 

Technical Support: 

1. What part of the application are you having issues with? 

a. For example:  installation issues with the Microsoft Dynamics CRM for Outlook client. 

2. Does the issue affect all users? A certain type of CRM role?  Only certain users? 

3. What is the exact error or the problem that you are experiencing?   

a. Provide as much detail here including the exact error message you are facing.  If possible, capture 

a screenshot of the error by clicking on Print Screen and pasting the results in MS Word or MS 

Paint. 

4. What are you doing in CRM Online when the error occurs? 

a. It is important to provide the exact steps you are going through to reproduce the error.  This 

allows the Support Team to better analyze why you may be experiencing the error. 

5. What are the details of the environment you are experiencing the issue on? 

a. Example: provide the version of the Microsoft Windows Operating System, Internet Explorer, and 

if applicable, the version of MS Office on the machine(s) the issue is occurring. 

6. If applicable, provide log files (if you know how to find them).  

a. This would apply to items such as the CRM for Outlook Client or the CRM E-mail Router.  The 

following describes where you can find the log files for these applications: 

i. Microsoft Dynamics CRM for Outlook logs:  

%Userprofile% \Local Settings\Application Data\Microsoft\MSCRM\Logs 

Microsoft Dynamics CRM for Outlook Trace files:  

%Userprofile% \Local Settings\Application Data\Microsoft\MSCRM\Traces 

ii. Microsoft Dynamics CRM E-mail Router: 

%Userprofile%\AppData\Roaming\Microsoft\MSCRM\Logs 

https://mbs.microsoft.com/customersource/worldwide/us/support/selfsupport/apss/default
http://www.crmonline.com/

